Written Makeup Lesson by Junie Sutton
Hi Beauty! If you’re reading this, it means that you got a makeup lesson with the one
and only Junique! You are about to read an amazingly detailed breakdown of how to
apply your makeup. I did my best to explain each and every step so that it would be
easy to learn while reading it off a page. Just so you know, this guide is not necessarily
meant to be read in one shot. You definitely can read the whole thing if you want to,
but it's more for a refresher on specific sections after your lesson. If you want a
reminder on how to contour, skip to the contour section, and so on and so forth.
Remember, this guide is for a full face of makeup. You don’t have to put on a full face
every day! Sometimes it's fun to just make your lashes and lips pop. Other times it's
great to have a clean looking skin like the “no makeup” look. So choose what you want
and have fun with it. I have tons of tutorials posted on my instagram @juniesutt that
are free to check out and always available to use.
I speak mainly here about the steps and not so much about products. If you
scroll down to the bottom, you can see my list of recommended products from each
category that I’ve either tried myself or heard are great from other people (both
drugstore & high end products). You can choose from that list which product you’d like
to use for the steps below. Additionally, I added a section listing your makeup vanity
necessities including what types of brushes you’ll need. I talk about brushes
throughout but the list on the bottom should help specify and put them all together for
you. Go to the bottom for more on that! Enjoy!
Quick Tips Before You Begin:
❏ Don't get overwhelmed by the length of this lesson. You don’t have to sit and
read it all in one shot. Think of it like an index. If one day you want to brush up
on your bronzing skills, then go to that section. If another day you want to brush
up on your eyeshadow skills, then only look at that section and so on….
❏ Breathe and take your time. Remember it’s all a learning experience. Practice
makes perfect.
❏ If something isn’t coming out the way you wanted, move on and revisit it. Don’t
spend too much time trying to make it perfect, you'll drive yourself crazy.
❏ Don’t overthink it. Start with two colors on a palette that are next to each other
and as you improve add more to your eyeshadow look.
❏ It doesn’t have to match your outfit exactly, that’s too predictable. Do something
that will compliment your outfit!
❏ Have Fun!!!
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Makeup Prep:
Now before we get into the actual steps, make sure you’re sitting, comfortable, and in
front of a mirror with good lighting so you can see what you’re doing! I personally love
listening to music while I do my makeup because why not make it more fun?! :)
❏ Step 1: Exfoliate your skin for a flawless, smooth makeup application.
❏ Step 2: Cleanse using a cleanser that’s fit for your skin type. Make sure you dry
your face by patting it with a towel and not aggressively rubbing the towel on
your face.
❏ Step 3: Tone- you can either use a wipe (like those wet toning wipes that come
in a container) or a spray. You can also do both. If your skin is oily or dirty then
do both.
❏ Step 4: Lip Scrub/Balm- for a super smooth lip application, scrub your lips and
apply lip balm. It’s better to do this in the beginning rather than the end
because it wears off perfectly enough that the lipstick won’t slip right off but
your lips are still smooth. If you put on lip balm right before you apply your lip
liner/stick, chances are it will slip off more easily and be harder to apply.
❏ Step 5: Serum- apply a small amount all over your face. Use one appropriate for
your current skin concerns (ex: First Aid Beauty Ultra Repair Hydrating Serum).
You can also use one special for makeup application that leaves a glowy look
underneath (ex: Farsali).
❏ Step 6: Eye Cream- apply with your ring finger gently under your eye area.
❏ Step 7: Moisturize- use a moisturizer that’s fit for your skin type. Apply all over
your face and neck. Don’t put too much.
❏ Step 8: Oil- helps to seal everything underneath your skin that you just applied.
The goal with moisturizer is to penetrate and deliver moisture to the skin where
the goal for oil is to lock in and seal that hydration. However, as a general
statement, thinner oils would usually go under moisturizer whereas thicker oils
go on top of moisturizer. If you use moisturizer and oil in your daily routine and
find that you’re applying it on top of moisturizer and don’t notice a difference,
try wearing it under your moisturizer. Pro Tip: You know your face and skin
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better than anyone. If you feel like moisturizer AND oil is too much, then apply
the more important one or less of each.
❏ Step 9: Prime- this helps set the makeup in place and makes it last all night
long. There are spray primers and cream primers, choose one from the list
provided. There are also primers based on the finish you want and your skin
type- choose wisely!
❏ Step 10: Prime your eyes with either a Mac Paint Pot (in colors Soft Ochre,
Painterly, or Bare Study) or an eyeshadow primer (like Shadow Insurance from
Too Faced). Be careful not to apply your eye primer too thickly or else your
eyeshadow will crease. I suggest that if you use the paint pots make sure you
don’t use too much and that you set them with a translucent powder before
applying your eyeshadow. You can apply the eye primer with any flat brush and
blend it out with a fluffy tapered brush. It doesn’t have to look perfect, it’s just
your base. I also sometimes like to use both, a small swipe of primer and then a
little bit of a paint pot or concealer for the base. I use the primer so it doesn't
crease, and the paint pot so there's a nude color to start with.
Makeup Application:
❏ Step 11: Eyeshadow- many people are intimidated by doing their own
eyeshadow. It’s actually not as hard as you think. My first tip always is- if you
really think you’re just incapable, put one color all over your eyelid and see how
that comes out! Once you get better you can start blending two, three, and even
more color combinations! For beginners I would suggest using those Stila glitter
tubes. If you choose to use those, be careful not to apply it too high. Apply it on
your eyelid and a little above but that's it. Aside from that, once you feel ready to
take on something more, you can start using a flat brush and a blending brush
to apply your shadows.
First apply a really light color (even highlighter) to your brow bone with a
blending brush. It will make your eyes pop. Then, start by taking your blending
brush and very gently brushing a medium color (also known as a transition
shade) across your crease. Feel free to tap the brush on a table before applying
so it doesn't get applied harshly. Go back and forth many times and blend away
but make sure not to go too high above your crease. Move the brush in little
swivel circular motions. If you want to add a color, gently place a darker color
on the outer parts of your eyes and then blend it out with a blending brush. Or
you can add a lighter color more towards the center of your eyelid. Keep the
JunieSutt Makeup Artistry

darker shade toward the outer parts of your eyes only. Dip the flat brush into a
light or shimmery color and drag it across your eyelid, starting from the inside
of your eye and finishing towards the center. The shimmery or lighter colors
should be on your lid towards the inside of your eyes and the darker colors on
the outer parts of your eyes. You can use an eyeshadow palette as a guide for
which colors to use and where. This is one style of eyeshadow called light to
dark. Pro Tip: For a beginner, I would recommend only starting off with one or
two colors for the outer lid and one shimmer on the inner parts of your eyes.
Work your way up as you improve.
If you want to make it more dramatic, you can add a teeny amount of the darker
color on the inner corner of the eye and blend that out too. This creates a “halo”
effect in which there is one lighter color in between two of the same darker
eyeshadow shades. This isn’t something I would recommend to a beginner and
it is a very specific type of look. I would recommend it for someone whose eyes
are far apart from each other. The darker color in the inner corners will give
them the appearance of the eyes looking closer together.
A third common eyeshadow technique is when the darker color is on top of your
eyelid and the lighter color is on the bottom. You place with a flat brush the
lighter color all over your eyelid. You then use the darker color in the crease
only and go back and forth in that specific area- not bringing it to that outer
corner of your eye. This one is a “sunset” style of eyeshadow.
❏ Step 12: Eyeliner- At this point, for a more natural look, you can choose to opt
out of putting eyeliner. Sometimes depending on the look, liner isn’t really
required/wanted. However, for the cases when liner is wanted, the following is
how it should be done: I would first recommend practicing eyeliner with no
eyeshadow on so that if you mess it up you can fix it. To start, use a pot with the
color liner that you’re using. Along with the gel pot, use a liner or angled brush
to assist you in putting on your liner. Dip the brush in the pot. Make sure you
don’t have too much product on the brush and that the product is smooth on it
so it won’t apply chunky or rigid. Depending on the brand, some liners may be
much drier than others. Be careful not to leave the pot open while you're lining
your eyes or you run the risk of drying out the whole pot. Additionally, use
Duraline from Inglot to help loosen the liner. It makes it glide much more easily
and helps with dryness of the product. DO NOT look up while using Duraline
unless you want the entire line you drew to transfer to the top of your eyelid. I
always direct by saying that everyone's eye shapes are different and it will
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definitely take time and practice to realize the way you like your liner to be. For
most eyelids, to start off I would say to line your eyes in the direction that your
bottom line of your eyes goes. It would be as if you are continuing the direction
of the line of your bottom of your eye in a more upward direction. However, for
hooded eyelids I would not necessarily suggest going according to that common
hack because the hoods of your eyelids may cover all your hard work. Again, it’s
trial and error. Here are a few other tips you can try whether your eyelids are
hooded or not. You can make a small baby wing according to the way I
suggested above, just don’t extend it out as much and it’ll be a mini baby wing.
You can also make a straight wing straight across your eye, and go in the
direction of your top eyelid, not the bottom one. This may be more flattering for
many eye shapes than the first tip. You can also line slightly according to the
bottom line of your eye and then finish lining with your eye open so you make
sure that it will show when your eyes are open. The shape might be funny when
you close your eyes so you can fill it in- it won’t show anyway when your eyes
are open. Depending on your age, if you have wrinkly eyelids you will have to
make a much thicker line because the line that ends up showing up will be
much thinner than what you draw when your entire lid is pulled back. The same
goes for Asian eyes- you will have to draw a much thicker line because when
you open your eyes your eyelid will cover most of the work.
❏ Step 13: Lashes- is another one of those things that you must practice doing on
yourself many times before you get good at it. It is very easy to get frustrated
while applying your own lashes so *deep breaths*. If you're a beginner, use
white lash glue (dries clear) to apply. If you’re more experienced you can use
darker/black lash glue but beware! If you mess up and smudge that black glue
on your eyelid, there’s no going back. You’d be able to patch it up with a little
makeup remover on a cotton swab and then go over again with
eyeshadow but it won’t be the same as how it was. A great
company for lash glue is Duo. Everybody
always asks me what the difference
between strip and individual lashes are.
Strip lashes are easier to apply, have more
of a dramatic flare to them (for the most
part) and are easier to remove. Individuals
are harder to apply, look more natural (for
the most part), and are a little more annoying to take off (be
careful not to rip out your own lashes!). However, to make it
even more confusing there are also individual trios which
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are basically like three lashes attached to each other and they’re a combination
betweens strip and individuals. In my opinion, you can make strip lashes look
natural and individuals look dramatic based on the type of lashes that they are,
and the amount of the lashes that you choose to apply. It’s important to make
sure the lashes you’re applying, strip or individual, will look good with your
eyes. If the strip is too long, cut it before applying. Do you like long individuals,
or medium or short? If your lashes aren’t naturally long, don’t apply long
individuals, they won’t look real or good. For strip lashes, apply a nice strip of
glue onto your lashes. Don’t be cheap with glue, put a nice strip on that lash (See
photo). Once you do that, let it dry for five minutes. Be patient or you will mess
it up. Once you let it dry, hold a handheld mirror below your chin and hold the
lashes with tweezers. The best way to get a view of how you're applying it is with
the mirror in this position and your head tilted back. Carefully place the lashes
on your lash line. It should be placed in that teeny area where your lashes and
eye lid meet (See photo). It will take multiple attempts, so this is another good
thing to practice without makeup on. If you’re using individuals, you will glue a
short line (dries faster than a glob) of glue down onto the pack of lashes. Once
you let the glue dry for approximately five-ten minutes, you can dip each lash
into the glue and apply it with tweezers as well with the mirror below your chin
and head tilted back. We’re going to wait until later on to apply mascara because
we want to make sure the lashes are dried and secured attached to your eyelid.
❏ Step 14: Foundation- When it comes to foundation you are going to have a few
decisions to make. First of all, the type of coverage you want. Firstly, that means
light coverage, medium, or full. But it also means, do you want your skin looking
more mattified, satin, or dewy? Once you make those decisions the next step is
to make sure it matches!!! Don’t make yourself orange. Find a foundation that
matches your neck. Our skin tones fall into a category of three. We are either
warm toned (yellow undertone), cool toned (pink undertone), or neutral
(somewhere in the middle). Take the time to look at yourself and decide which
category you fall under. This should help when choosing your color. Once you’ve
made your match the next step is application. You can either use a foundation
brush (Sephora #47 is a great one), a sponge (Elf makes a great $4 one!), your
fingers, or a combination of all of those. Make sure you blend evenly ALL over
your face, that means closing your lips and getting on that mustache and chin
area. That also means getting your nose and basically yeah everywhere. Also
don’t forget to blend it into your neck. If it's a good match then you shouldn't
have to do that much to make it match your neck anyway. If it looks a little light,
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don’t worry. Our necks are generally lighter than the rest of our face anyway
and the bronzer will bring back all that tan.
❏ Step 15: Color Corrector is great to use for when our lovely friend Mr. Pimple
visits our face right in time for an event. It is also great for dark circles under
your eyes that are super dark or unusually dark, or really any spots on your face
that would need a little more than foundation and concealer to cover it up with.
Depending on the color of the thing you're covering, as well as your skin tone,
there are a few different color correcting techniques you can use. For the most
part, the colors that you’d use to correct are salmon, red, or green. Salmon I
would use for under eye, red I would use for anything a little darker than that
and green I would use for redness. Additionally, a lot of people don’t realize that
you are not supposed to blend in color correctors. It is supposed to lay on top of
the area you are trying to cover and the concealer will do the rest of the work in
terms of covering up. So don't try to blend in the color corrector or you are
completely removing its purpose.
❏ Step 16: Concealer- put it on any color corrected spots as well as under your
eyes. Use a concealer brush or straight from the tube (if it has a wand) since it's
your own. Don’t put too much in one area or it will
crease. If you put too much, blend it out with a small
fluffy brush to thin it out and set with a translucent
powder. Or you use fingers and lightly dab.
❏ Step 17: Contouring- I want to explain a little bit of the
difference between contouring and bronzing because
they aren’t exactly the same. Our faces have certain areas
where shadow naturally hits. Contouring deepens those
shadows creating a more chiseled, defined, and sculpted
effect. Bronzer then takes it to the next level by adding
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some warmth, like adding a “tan.” You can still skip contouring and bronzer will
definitely make up for what you skipped, but contouring is more about defining
the parts we like about our face shape where bronzing is more about adding a
tanned effect on top of that. With that being said, I’m going to separate
contouring into cream products only and bronzing into powders only. For
contouring, you can use either a cream contour palette, or cream contour pens.
If using a palette, you can use a concealer brush to apply the contour. Use two
different brushes for the lighter, concealed areas and the brown contour so you
don’t mix them. If you’re using a contour pen, usually it has a brush already
attached to it so that’s great. See the photos attached to see where to place the
dark lines and the light lines. The dark lines go in the areas that shadow
naturally hits. The light lines are going in the places you want to bring out and
accentuate. Once you’re done “drawing” those lines, it’s time to blend. You can
use a fluffy brush or a sponge to blend. I would recommend using both where
necessary. Start by blending out the “concealed” or lighter areas first. Make sure
you don’t blend too much of anything because then it defeats the purpose of
what you’re trying to achieve. Next, blend in the darker areas. Again, don’t over
blend, but also don’t under blend either because that’ll look weird lol. Once
you’re happy with how it’s all blended out, now it’s time to set it.
❏ Step 18: Translucent Powder- is great for setting in all the previous makeup that
was applied and setting up a base for powder bronzer and blush. Pro Tip: If you
applied your cream contour, then apply translucent powder after. If you just
want to apply bronzer, then apply translucent powder before. There are two
options for translucent powder: for a more natural option, all you have to do is
lightly brush translucent powder all over your skin. Make sure to get under your
eyes to avoid concealer creases. If you are going for a more extreme and matte
contoured look, apply a loose translucent powder only over the “concealed” or
“lighter” areas with a brush. Leave it there for ten minutes and when you’re
done lightly brush off the excess. This will leave you with a smooth flawless
matte application. This process is called “baking.” Pro Tip: Cream always goes
under powder. If you try to apply cream on top of powder it will mess up any
work you did before it and essentially erase all your hard work.
❏ Step 19: Bronzer- I always like to tell my clients that bronzer gets applied in the
shape of a number 3 on both sides of your face (however I'm not gonna lie
sometimes I just bronze all over). For a more defined look, though, you should
put bronzer in that shape 3. On your forehead area, mid cheek area and lower
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face and neck area. Really wherever the sun hits, so even your nose works. Use
an angled face brush or a big fluffy face brush to apply.
❏ Step 20: Blush- if you pinch your cheek, see what colors it quickly turns. If you
take a quick run around the block, see what color your skin flushes to. That is
the color of blush you should be using. There are many different spots you can
apply blush and they all depend on the look you're going for. The most “normal”
spot would be basically smiling and putting it on the balls of your cheeks when
you smile and blending it in an upward and outward motion away from your
face. For something a little different, I've seen people bring the blush up to their
cheekbone area where highlighter usually goes. Also you can put on your nose
so it looks like a little natural touch of sun. Blush is the first thing to fade so
don't be afraid of putting too much, it will go away.
❏ Step 21: Highlighter- one of my personal favorites, highlighter is the perfect
product to use when going for a dewy and glowy look. Highlighter can be
applied with a fan brush or a special highlighting brush which is basically a
large fluffy tapered brush. I'd prefer to use that over a fan. You apply it high up
on your cheekbones as well as your nose and fulcrum (that thingy on top of your
lips) you can also put a little on your chin. All depends on how glowy you want to
be.
❏ Step 22: Eyeliner (bottom)- as far as eyeliner goes, you can apply it in your
waterline as well as outside your waterline. What does this mean? Inside your
water line is literally inside your eye, when you have to open up your eyelid and
put eyeliner basically. Outside the water line is under your eye, under your
eyelashes and outside of your eye. I love applying on the outside and connecting
it to the line that was made with liner from a wing. Be careful with lining the
inside of your eye. If you have a small eye you shouldn't line the inside of your
eyes with black. It will close them up even more. You can line the inside with a
nude but not a white because it gives off scary vibes lol it’s too much. If you have
big buggy eyes this is a good opportunity to use black liner in the waterline.
However, I always like to put a pop of something under my eye. I do that
because it helps open the eye even when black liner is applied to the inside. You
can use a pencil that sharpens, a retractable pencil, gel like from the top liner,
and if you're going outside your waterline, eyeshadow!
❏ Step 23: Mascara- If you’ve already applied lashes or you just want to apply
mascara on your natural lashes, curl them with a lash curler before applying the
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mascara. Make sure you don’t just clamp the curler on one section of your
lashes, rather, you should open and close it as you curl up your lashes so they
stay in a nice curled shape rather than just bending them upwards. Mascara
may seem like one of the easier steps however there’s definitely precision to it.
You have to make sure you coat all your lashes from root to end. Sometimes this
means using more than one mascara to do so. Just be careful that you don’t get
mascara on your upper eyelid where your eyeshadow is. If there’s no eyeshadow
there and you do get mascara in that area, then let it dry and use a cotton swab
to remove the black. Make sure every lash has mascara on it horizontally as well.
Don’t forget the bottom lashes. You can try using a mascara brush instead of a
typical spoolie to get all the way to the root. You can also use an eyelash
separator after applying the mascara to separate any clumps.
❏ Step 24: Fill your eyebrows with the amount that you like. Don’t get too close to
the center of your forehead, where your eyebrows meet- that’s how you create
“angry brows.” It makes them too harsh and honestly, fake looking. I like to use
an eyebrow pencil- Anastasia Beverly Hills has a great one- one side has an
eyebrow brush and the other side has a pencil. The brush can be used as an
eraser if you ever feel like you put too much product on your brows. Another
great option is to use a brow pomade with an angled brush to fill your brows.
You can use brow powder with an angled brush as well. If you don’t have any
brow products, find a brownish eyeshadow color that matches your eyebrows
and use that with an angled brush.
❏ Step 25: Lips- For a long lasting lip, you want to start by lining your lips with
your color of choice. Personally, I don’t like when the liner and lip color are two
completely different colors. It looks weird/fake to me and only in rare cases
looks good. Line a little bit above your lips and color in th elines, so make sure
your whole lip is filled with lip liner. This will ensure a long lasting lip. Next, you
top it off with your favorite lipstick. It can be a little lighter, match the liner, and
it can either be applied over the entire coat of liner or just within the lips. Once
lipstick has been applied you can top it off with a gloss. Be careful though, it is
more likely to smudge (not last as long) with gloss on top.
❏ Step 26: Setting Spray- This step just helps seal it all in. Spritz your face from
far with the setting spray of choice. Your makeup will last much longer and have
a nice dewy touch to it! If you don’t want that dewy touch, there are also matte
setting spray options. I will attach a list with all products that I’ve either used
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myself or heard were great from other people and you can choose which item
from each category you want to buy.
❏ Quick Tip: Brushes- I would recommend using Cinema Secrets Brush Cleaner in
between uses and cleansing with soap and water once a week. In order to serve
your skin best, it is best to follow these cleaning rules.
Makeup Vanity Necessities:
Tools:
❏ Cotton Swabs
❏ Makeup Remover
❏ Tissues
❏ Garbage Bag/Can
❏ Brush Cleaner
❏ Hand Sanitizer
❏ Sharpener
Brushes:
❏ Face
❏
❏
❏
❏
❏
❏
❏ Eyes
❏
❏
❏
❏
❏

Sponge- rinse in sink and squeeze out excess water
Contour Brush- for bronzer
Highlight Brush
Concealer Brush
Blush Brush
Extra Face Brush- to brush all over the face when all the face makeup is
done to blend it all together
Angled Liner Brush or Precision Liner Brush
Tapered Blending Crease Brush
Mini Tapered Blending Crease Brush- to deepen
Flat Eyelid Brush
Flat Mascara Brush- to get to the root of the lash
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Products:
For links to shop the products below, click https://shoplist.us/juniesutt. Each product is
separated by category.
The list of products below gets updated every three months and the new/future
versions can be downloaded from www.JunieSutt.com
Skin Care:
Pimple Patches:
➔ COSRX Clear Fit Master Patch
➔ Mighty Patch Invisible+
➔ Peace Out Acne Salicylic Acid Acne Healing
Dots
➔ Rael Beauty Miracle Patch
Makeup Removers:
➔ Bioderma
➔ Bliss Makeup Melt Oil Free Makeup Remover
➔ Elemis Pro-Collagen Cleansing Balm
➔ Garnier Micellar Water
Cleansers:
➔ Biologique Lait U
➔ Cetaphil Facial Cleanser
➔ Cerave Foaming Cleanser
➔ Cerave Hydrating Cleanser
➔ Garnier Skin Active Micellar Foaming
Cleanser
➔ Glossier Milky Jelly Cleanser
➔ Indie Lee Rosehip Cleanser
➔ La Roche Posay Toleriane
➔ Mario Badescu Glycolic Foaming Cleanser
Toners:
➔
➔
➔
➔
➔
➔
➔
➔

Biologique Recherche Lotion P50W
Biologique Recherche Lotion P50 1970
First Aid Beauty Facial Radiance Pads
Fresh Rose Toner
Indee Lee CoQ-10 Toner
Neogen Toning Wipes in Lemon
Neogen Toning Wipes in Green Tea
Thayer’s Rose Petal Toning Towelettes

Moisturizers:
➔ 10.0.6 Seriously Shine Free
➔ Alba Botanica Moisturizer
➔ Cetaphil Deep Hydration
➔ Cetaphil Moisturizing Lotion
➔ Charlotte Tilbury Magic Cream
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Foundations:
➔ Charlotte Tilbury Airbrush Flawless (Full
Coverage)
➔ Charlotte Tilbury Beautiful Skin Medium
Coverage Foundation
➔ Charlotte Tilbury Light Wonder
➔ Dior Airflash
➔ Estée Lauder Double Wear Foundation
➔ Face Atelier Foundation
➔ Giorgio Armani Luminous Silk
➔ Inglot HD Perfect Cover Up
➔ Laura Mercier Tinted Moisturizer
➔ L'oreal Infallible Pro Matte Foundation
➔ Mac Studio Fix Fluid
➔ MUFE Invisible Cover Foundation
➔ Nars Light Reflecting
➔ Nars Soft Matte Foundation
➔ Nars Radiant Foundation
➔ Revlon Insta-Filter Photoready Foundation
➔ Tom Ford Shade & Illuminate Soft Radiance
Correctors & Concealers:
➔ Armani Luminous Silk Concealer
➔ Covergirl TruBlend Undercover Concealer
➔ Fenty Beauty Pro Filt’r Instant Touch
➔ Inglot Under Eye Concealer
➔ Kat Von D Lock It Concealer Creme
➔ Kosas
➔ LA Girl Concealer
➔ Mac Concealer Palette
➔ Mac Studio Finish Concealers
➔ Makeup Forever Underpainting Color
Correction Palette
➔ Nars Radiant Creamy Concealer
➔ Nars Soft Matte Concealer
➔ Surratt Surreal Skin Concealer
➔ Surratt Concealer Palette
➔ Too Faced Concealer
➔ Tarte Shape Tape Concealer (Oily Skin)
Translucent Powder:
➔ Airspun Loose Face Powder

➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔

Elizabeth Arden Eight Hour Cream
Erborian Yuza Double Lotion
Erborian CC Dull Correct
First Aid Beauty Coconut Water Cream (Oily
Skin)
First Aid Beauty Ultra Repair Cream Intense
Hydration Moisturizer (Dry Skin)
Freck Ritch Bitch Moisturizer
Genius Sleeping Collagen
Grown Alchemist Tinted Hydra-Repair Day
Cream
Olay Regenerist
Origins Mega Mushroom Relief and Resilience
Lotion
SkinCeuticals Triple Lipid Restore
Supergoop Unseen Sunscreen
Supergoop Glow Screen
Supergoop Matte Screen
Tatcha The Dewy Skin Cream
Weleda Skin Food

Body Moisturizers:
➔ Environ Body Essentia Alpha-Hydroxy
Derma-Lac Lotion (for KP)
➔ Environ Body Essentia Vitamin A, C, & E Body
Oil (for KP)
➔ Patrick Ta Body Oil
Oils:
➔
➔
➔
➔

Biossance Squalane Oil
MUFE Ultra HD Skin Booster
Nuxe Multi Purpose Drying Oil
Tax Luxe The Face Illuminating Self-Tan
Drops

Eye Creams:
➔ Clinique Pep Start Eye Cream
➔ Embryolisse Eclat du Regard
➔ Estee Lauder Advanced Night Repair
Synchronized Recovery Complex II
➔ Glam Glow Bright Eyes Eye Cream
➔ Molton Brown Eye Gel
➔ Peter Thomas Roth Retinol Fusion PM Eye
Cream
➔ The Ordinary Caffeine
➔ Tonymoly Moisture Boost Hydro Gel Eye
Patches
Serums:
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➔
➔
➔
➔
➔

Charlotte Tilbury Airbrush Flawless Finish in
2 (Pressed Powder)
Hourglass Ambient Powders
Huda Cupcake
Inglot (Loose Powder)
Laura Mercier (Loose Powder)

Bronzers:
➔ Anastasia Beverly Hills
➔ Benefit Hoola
➔ Bobbi Brown
➔ By Terry Tea to Tan
➔ Charlotte Tilbury Airbrush Flawless
➔ Drunk Elephant D-Bronzi Anti-Pollution
Sunshine Drops
➔ Guerlain Terracotta Bronzing Powder 04
➔ Mac in Golden
➔ Mac Mineral Skin Finish in Deep
➔ Nars Laguna
➔ Tom Ford Shade & Illuminate
➔ Too Faced Milk Chocolate/Chocolate Soleil
Blushes:
➔ Bobbi Brown Santa Barbara 13
➔ Charlotte Tilbury Cheek to Chic Walk of No
Shame
➔ Charlotte Tilbury Cheek to Chic Ecstasy
➔ Charlotte Tilbury Cheek to Chic Pillow Talk,
Pillow Talk Intense
➔ Nars Orgasm Powder & Liquid Blush
➔ Makeup By Mario Mellow Mauve
➔ Maybelline Cheek Heat Cream Blush
➔ Senna Slipcover Cream to Powder Cheeky
Blush Palette
➔ Tarte Amazonian Clay 12-Hour Blush in
Paaarty
Highlighters:
➔ Anastasia Beverly Hills Glow Kit
➔ Becca Rose Gold
➔ Dior Backstage Collection Universal Glow
➔ Iconic Liquid Highlight
➔ Kevyn Aucoin Glass Glow Highlighter in Rose
Gold or Bronze
➔ Hourglass Cosmetics Ambient Lighting Palette
➔ Natasha Denona Glow Gold Highlight Duo
➔ Smashbox x Becca Champagne Pop
➔ Westmann Atelier Super Loaded Tinted
Highlight

➔
➔
➔
➔
➔
➔
➔

Dr. Jart Cicapair Tiger Grass Serum
First Aid Beauty Ultra Repair Hydrating
Serum
Glossier Futuredew
Laneige Glowy Makeup Serum
Sunday Riley A+ Serum
The Ordinary Retinol
The Ordinary Azelaic Acid Suspension 10%

Vitamin C Products:
➔ Biossance Squalane + Vitamin C Oil
➔ Dew Care Vitamin C Serum
➔ Mario Badescu Vitamin C Serum
➔ Murad Multi-Vitamin Infusion Oil
➔ Ole Henriksen Vitamin C Serum
➔ Paula’s Choice C15 Super Booster
➔ Skinceuticals C E Ferulic
➔ The Ordinary Vitamin C Suspension (23% &
30%)
Hair Products:
➔ Amika Soulfood Mask
➔ Act + Acre Cold Pressed Scalp Detox
➔ Elchim Hair Dryer
➔ Eva Nyc Mane Magic 10 in 1 Priming Spray
➔ IGK Beach Club Texturizing Spray
➔ IGK Charcoal Detox Dry Shampoo
➔ IGK Good Behavior Spray
➔ IGK Mistress Hydrating Hair Balm
➔ IGK Rich Kid Coconut Oil Gel
➔ Kerastase Smoothing Taming Milk
➔ Kellie Little Hair Brush
➔ L'oreal Everpure Frizz Defy Shampoo &
Conditioner
➔ Olaplex Shampoo & Conditioner
➔ Shhhowercap
Makeup:
Lash Glue:
➔ Duo Lash Glue Clear & Dark Tone
Eye & Face Primers:
➔ Il Makiage No Filter Primer
➔ Mac Paint Pots- Soft Ochre, Painterly, Bare
Study (Eyeshadow Primers)
➔ Makeup Forever Step 1 Redness Correcting
Primer & Shine Control
➔ Milk Hydro Grip Primer
➔ Smashbox Photo Finish Foundation Primer
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Mascaras:
➔ Benefit Bad Gal Bang
➔ Clarins Double Fix Mascara
➔ Diorshow Iconic Overcurl & Waterproof
➔ Essence Lash Princess False Lash Effect
(Regular & Waterproof)
➔ Ilia Beauty Mascara
➔ Kevyn Aucoin The Volume
➔ Lancome Monsieur Big Mascara
➔ Lancome Cils Booster XL Super Enhancing
Mascara Primer
➔ Laura Mercier Caviar Volume Panoramic
Black
➔ L’Oréal Bambi Eyes (Regular & Waterproof)
➔ L’Oréal Double Extend (Red & White Tube)
➔ L’Oréal Paradise Voluminous Lash Paradise
Primer
➔ L’Oréal Voluminous Lash Paradise Mascara
(Regular & Waterproof)
➔ L’Oréal Voluminous in Blackest Black
➔ L’Oréal Voluminous Waterproof in Carbon
Black
➔ Maybelline Sky High
➔ Neogen Dermalogy Extra Slim Metal Maxicara
Black
➔ Smashbox Lash Primer
➔ Thrive Causemetics Liquid Lash Extensions
➔ Too Faced Better than Sex Mascara
Lips:
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔
➔

Blistex Lip Medex
Buxom Plumping Lip Polish in Celeste,
Dominique, Sophia
Careline Lipsticks
Charlotte Tilbury Pillow Talk Lip Liners and
Lipsticks
Charlotte Tilbury Matte Revolution Lipstick in
Very Victoria- taupe nude
Dose of Colors Liquid Lipstick in Cork
Kevyn Aucoin The Molten Lip Color in Dolly,
Nicole, Janet & Tori
Kylie Matte Lip Kit in Kylie
Mac Lipstick Cream in Creme In Your Coffee
(creamy mid tone pink brown- cremesheen)
Mac Satin Lipstick in Verve
Mac Matte Lipstick in Kinda Sexy
Mac Dare You (Red)
Mac Media (Dark Red)
Mac Lipglass

➔
➔
➔

Smashbox Primerizer
Too Faced Hangover Primer
Too Faced Shadow Insurance Eyeshadow
Primer

Eyebrows:
➔ Anastasia Beverly Hills Brow Wiz
➔ Anastasia Beverly Hills Brow Freeze
➔ Maybelline Eyebrow Pencils
➔ Patrick Ta Brow Wax
➔ West Barn Co Soap Brows
Eyeshadows:
➔ Charlotte Tilbury Jewel Pots Pillow Talk
➔ Charlotte Tilbury Pillowtalk Palette
➔ Charlotte Tilbury Pillowtalk Palette of Pops
➔ ColourPop Palettes
➔ Dior Backstage Eyeshadow Palettes (Warm,
Cool, Rosewood Neutrals)
➔ Giorgio Armani Eye Tint Liquid Eyeshadow
Matte
➔ Hourglass Scattered Glitter
➔ Huda Obsessions Purple Haze
➔ Lorac Pro Palette Noir
➔ Mac Loose Pigment Powders
➔ Mac Silky Metallic Eyeshadow Sweet Heat
➔ Makeup Forever Matte Eyeshadows
➔ Marc Jacobs Sequins
➔ Morphe Jaclyn Hill Palette
➔ Morphe James Charles Palette
➔ Makeup by Mario Shimmer Palette
➔ Naked by Urban Decay Palettes
➔ Natasha Denona Biba & Gold Palettes
➔ NYX Loose Metallic Pigments
➔ Pat McGrath
➔ Rare Beauty Palettes
➔ Sigma Beauty Ambiance Eyeshadow Palette
➔ Stila Liquid Eyeshadows
➔ Tartelette in Bloom Clay Eyeshadow Palette
➔ Tartelette Juicy Amazonian Clay
➔ Too Faced Chocolate Gold
➔ Too Faced The Natural Nudes Palette
➔ Viseart Neutral Mattes, Paris Nudes, Paris Edit
➔ Wet n Wild Palettes
Eyeliners:
➔ Il Makiage Ink Liner in Black
➔ Inglot 77 Black Gel Eyeliner
➔ L’Oréal Infallible Eyeliner
➔ Mac Chromaline in Black Black
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➔
➔
➔
➔
➔
➔
➔

Makeup Forever Endless Cacao Lip Pencil
Maybelline Glosses
Milani Lip Liner Pencils
Nars Sheer Lipstick in Sexual Healing &
Tolede
Sephora “Perfect Nude” Lip Gel
Stila Lip Glazes
Supergoop Lip Balm

Setting Spray:
➔ Charlotte Tilbury Airbrush Flawless Finish
➔ Mac Fix+
➔ Tru Colors Cucumber (@trucolors.shoppe on
Instagram)
➔ Urban Decay All Nighter
Brushes:
➔ Bdellium Tools
➔ Beauty Blender
➔ Blender Cleanser Brush Cleanser
➔ Cinema Secrets All Natural Brush Soap
➔ Cinema Secrets Brush Cleaner
➔ Cinema Secrets Brush Cleansing Shampoo
➔ Dawn Liquid Soap- for washing brushes
➔ Elf- great inexpensive brush options
➔ Elf Angled Total Face Sponge
➔ Mac Brushes
➔ Mac 231S Synthetic Small Shader Brush
➔ Mac 263S Synthetic Small Angle Brush
➔ Mac Brush Cleanser
➔ Morphe- great inexpensive brush options
➔ Morphe M439 Deluxe Buffer
➔ Morphe M456 Mini Firm Blending Brush
➔ Morphe E36 Detail Crease
➔ Morphe x Ariel Signature Look 12-Piece Face
& Eye Brush Set
➔ My Kit Co My Detailed Smudge Brush 1.13, Pro
1.17 My Tiny Angle Brush
➔ Nars Yachiyo Brush (for blush)
➔ Palmat Brush Cleaning Pad/Glove
➔ Real Techniques
➔ Sigma
➔ Sephora Collection Pro Eye Liner Brush #22
Other:
➔
➔
➔
➔

Blinc Heated Lash Curler
Esmalte Endurecedor para Uñas (Nail
Hardener)
Eyelash Separator
Freck- freckles

➔
➔
➔

➔
➔

Sephora Brand Eyeliner
Sephora Eyeliner Liquid Intense Ink Liner
Surrat Auto-Graphique Liner in Chat Noir
Urban Decay 24/7 Glide On Eye Pencil (All
Colors)
Urban Decay Heavy Metal Glitter Eyeliner

➔
➔
➔
➔
➔
➔
➔
➔
➔
➔

Inglot Duraline
Makeup Forever 12 Flash Color Case
Mascara Spoolies
Neewer Makeup Ring Light
Palette & Knife
RCMA Foundation Thinner
Sex Apeel Spray Exfoliator
Tabletop Makeup Vanity Mirror
Zuca- makeup bag
70% Alcohol

Makeup Routine:

1. Toner
2. Lip Balm
3. Serum
4. Eye Cream
5. Moisturizer/Oil
6. Primer
7. Eyeshadow Primer
8. Eyebrows
9. Eyeshadow
10. Eyeliner (top)
11. Lashes
12.Foundation
13.Color Corrector
14.Concealer
15. Contour
16. Translucent Powder
17. Bronzer
18. Blush
19. Highlighter
20. Eyeliner (bottom)
21.Mascara
22. Lips
23. Setting Spray
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